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Moving from FreeHand  
to Illustrator

When moving from one powerhouse application to another, you’ll encoun-
ter two main concerns. First, how do you migrate all your existing content 
from one application to another? Second, and perhaps more important, how 
do you familiarize yourself with conceptually different functions, new key-
board shortcuts, and, in many cases, an entirely new workflow? The good 
news is that Adobe has already taken care of the first concern.

Unlike Adobe Illustrator CS2, which could open only native Macromedia 
FreeHand 9 files, Illustrator CS3 has the ability to open native FreeHand 
10 and FreeHand MX files. In the process of doing so, Illustrator will do 
its best to retain as much of the file in an editable state as possible. In fact, 
Illustrator does a wonderful job of this, making it possible to migrate con-
tent easily from FreeHand. You can open a FreeHand file the same way  
you would open an Illustrator file, at which time you’ll be presented with a  
FreeHand Import Options dialog (Figure 1 on the following page). You’ll 
find that almost all the content in the file will be imported and remain edit-
able as well.
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The second concern is a far greater task. However, as an already proficient 
FreeHand user who now desires to get up to speed in Illustrator, you are 
about to find yourself ahead of the game when it comes to moving toward 
program versatility.

Do not look to this guide for a global pronouncement as to which of the 
two applications is better. The answer to that question depends upon 
another: “Better at what?” It would be wonderful to take the best treatment 
of each feature from each program (and if we did, we would have to include 
some features from CorelDRAW, Corel Designer, and Deneba Canvas in 
the mix) and combine them into one ideal vector-based commercial illustra-
tion program. Don’t count on that happening anytime soon, though.

As a final assurance, before you dive in head first, know that we wrote this 
guide to help you learn a new tool. Its tone is unbiased, and your expertise 
is assumed and, more important, respected. We assume an intermediate-
level proficiency with FreeHand.

Getting Your Feet Wet
Despite the initial bewilderment you deal with when faced with a new pro-
gram, you’ll soon find that your FreeHand experience proves advantageous 
in Illustrator. If you are proficient with FreeHand, you already have a con-
ceptual understanding of the principles of vector drawing.

Figure 1  New in Illustrator 
CS3, you can open native 
FreeHand MX files and  
maintain the integrity of 
the file, making it easier 
to migrate content from 
FreeHand into Illustrator.

Figure 1  New in Illustrator 
CS3, you can open native 
FreeHand MX files and  
maintain the integrity of 
the file, making it easier 
to migrate content from 
FreeHand into Illustrator.
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The key to quickly achieving a matching proficiency in Illustrator is to 
try to discover the underlying behavioral principles. Don’t worry so much 
about locating every specific tool or command. Even if you find the tool 
you’re looking for, you might find that it doesn’t seem to work correctly or 
that it seems frustratingly backward or illogical. When this is the case, run 
a mental check on the underlying principle and do a little experiment off 
to the side to boil down the essential issue; you’ll find that you are merely 
struggling with a different interface layered on a familiar principle. At this 
point, you will begin to see your “adversary” in its true smaller perspective, 
and you will feel much less overwhelmed.

This is the strategy we’ll employ in the following pages. Rather than memo-
rizing a dizzying catalog of specific commands, you will use the under-
standing of basic vector path principles that you already possess and then 
figure out the way Illustrator “thinks” as you go.

The overall goal here is to give you, the already-experienced FreeHand user, 
a boost over that initial frustration hump so that you can get on with explor-
ing the myriad features found throughout Illustrator.

When trying to adapt to a program that is supposed to be so functionally 
similar to one we already know, many of us make a basic assumption and 
commit a basic error: we tend to think it is just a matter of finding cor-
responding commands and memorizing their locations. We get frustrated 
when we find out it isn’t quite as simple as that.

This naive assumption leads to nasty surprises and confusion, especially 
when two programs are so similar in purpose—and even general design— 
as FreeHand and Illustrator.

What we fail to consider is that even if the “equivalent” command we seek 
is present, it may operate according to a different set of givens—a differ-
ent set of underlying principles of behavior. In fact, as you shall see in a 
moment, even the mere location of a command may cause it to act quite dif-
ferently from what we’d expected based upon years of experience and habit 
in another program.

Comparing Underlying Similarities
First, take a deep breath and rest assured that the basic paths, points, and 
handles that make up Illustrator’s vector paths are the same objects as those 
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you are accustomed to creating and manipulating in FreeHand. Both pro-
grams draw Bézier paths. As in FreeHand, the following items are true  
for Illustrator:

•	 Paths are either open or closed and can have fills and strokes.

•	 Paths are connected by, or end at, anchor points.

•	 All paths have an inherent “direction,” and even if closed, they have a 
start /end point.

•	 Points are either corner anchor points or smooth anchor points (there is 
no connector point in Illustrator).

•	 Smooth anchor points have two direction handles each, which can be 
individually extended or retracted to affect the shape of their associated 
segments.

So, the basic building blocks of Illustrator vector objects are practically iden-
tical to those in FreeHand. It follows, then, that the basic functions that you 
can do with paths are also very similar:

•	 You can combine multiple paths into composite paths (called compound 
paths in Illustrator) to create shapes with holes in them.

•	 You can group multiple paths (with or without other objects) so that 
you can manipulate them as a unit.

•	 You can use paths as masks for other paths (a clip path in FreeHand is 
called a clipping path in Illustrator).

•	 Stacks of paths can be automatically generated to give the appearance of 
smooth color and/or shape transitions (called blends in both programs).

•	 You can add or subtract paths from each other to create new paths  
(via Combine operations in FreeHand and pathfinders in Illustrator).

But even while you are performing the same kinds of operations upon 
the same kinds of objects, there are some differences. Each command can 
employ a different method of accomplishing its purpose, can present the 
user with a different set of parameters, and can exist within a different  
organizational scheme than those of the more familiar program.
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Conceptual Differences: Working with Color
To both illustrate and emphasize the earlier conceptual gibberish, we’ll start 
with what may be a mildly startling example. What could be more basic 
than the simple matter of selecting and applying a fill color to a path? Surely 
this process is practically identical in both programs? Well, let’s see.

FreeHand and Illustrator both have the expected Color panel, where colors 
are mixed (called the Color Mixer panel in FreeHand), and the Swatches 
panel, where defined colors are stored. You can apply colors, of course, to 
strokes and fills. So far, so good. But there’s a not-so-subtle difference that 
makes all the difference. In FreeHand, the fill/stroke indicator resides in the 
Swatches panel, whereas in Illustrator, it resides in the Color panel (and in 
the Tools panel).

This is just an organizational thing, but it’s one with confusing conse-
quences. In FreeHand, because the fill/stroke indicators are in the Swatches 
panel, it doesn’t matter whether a path is selected while you adjust the mixer 
sliders; the path is unaffected (Figure 2). But in Illustrator, where the 
fill/stroke icons are right there in the same panel as the mixer, the selected 
object’s color changes as you drag the sliders (Figure 3). You’re not just 
mixing a color; you’re mixing a color and applying it to a fill or a stroke 
at the same time, and you’d better be aware of this if anything is selected, 
because whatever is selected will change in color.

	

	

Figure 2  FreeHand: The fill/
stroke icons are not in the 
Color Mixer panel. Changing 
values does not affect the 
selected objects because 
you are mixing a color that 
is not necessarily yet a 
swatch, fill, or stroke.

Figure 2  FreeHand: The fill/
stroke icons are not in the 
Color Mixer panel. Changing 
values does not affect the 
selected objects because 
you are mixing a color that 
is not necessarily yet a 
swatch, fill, or stroke.

Figure 3  Illustrator: The fill/
stroke icons are right there 
in the Color panel. Changing 
values affects selected 
objects because you are 
adjusting a color that is 
either a fill or a stroke.

Figure 3  Illustrator: The fill/
stroke icons are right there 
in the Color panel. Changing 
values affects selected 
objects because you are 
adjusting a color that is 
either a fill or a stroke.
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So you see? Just knowing where to find the corresponding fill/stroke toggles 
within the two programs doesn’t really help you understand the program. 
You have to examine the underlying principles—the ramifications—of what 
that change of location entails before you come to grips with that nagging 
confusion you feel when you’re mixing and applying colors.

Can one method be called right and the other wrong? Probably not. It 
can be argued that the FreeHand approach encourages you to define color 
swatches before you actually apply the colors to objects. On the other hand, 
the Illustrator approach enables something you may not discover even after 
years of working in the program. Suppose you have two (or more) objects 
selected. Each has a different fill color, but they both share a particular com-
ponent value (say, they both have a 10% K component). In such a situation, 
the slider handle and value appear only for that common component in 
Illustrator’s Color panel. You can adjust that component for all the selected 
objects in a single move (slide the K slider to 20%, and you have darkened 
both selected paths by 10%) (Figure 4). If the value of a particular compo-
nent differs across the selected objects (say one contains 10% C and another 
contains 5% C), you can equalize them in one move by entering a value for 
that component. (Enter 15% in the C field; the other components remain 
unaltered.)

Offering a Word of Encouragement
Many years of engrained habit can be difficult to reprogram, but don’t sell 
short that marvelous analog computer between your ears. Many (no, not 
all) of the difficulties that seem so awfully tedious at first are short-lived. 
You will undoubtedly find yourself pleasantly surprised that after the initial 
frustration, somewhere fairly early along the way, the mental bells will go 
off about the underlying principle involved (“Of course! The selection is 
affected when I mix colors! The fill/swatch selectors are right there in the 
Color panel!”), and you will stop stumbling over this difference.

FreeHand has a similar 
capability in its Color 

Control Xtra. But here also, 
the organization principle is 
different between two “corre-
sponding” features. The sliders 
in this dialog start at zero and 
add the value(s) you enter 
there to the present values of 
each selected object.

FreeHand has a similar 
capability in its Color 

Control Xtra. But here also, 
the organization principle is 
different between two “corre-
sponding” features. The sliders 
in this dialog start at zero and 
add the value(s) you enter 
there to the present values of 
each selected object.

Figure 4  The treatment in 
Illustrator means you can 
adjust a shared component 
of all selected objects at 
once without affecting the 
other components.

Figure 4  The treatment in 
Illustrator means you can 
adjust a shared component 
of all selected objects at 
once without affecting the 
other components.
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First Steps: Learning the  
User Interface
You’ve just arrived, switched off the ignition, grabbed the suitcase, walked 
up the porch steps, and swung open the door. Already you can see that the 
floor plan and decor is rather different from the place from which you came. 
Go ahead—step inside, and flip on the switch.

Multiple Pages, Where Art Thou?
The basic document environments for FreeHand and Illustrator are so simi-
lar it hurts. Why this pain? Because the environment in Illustrator is almost 
identical to FreeHand 3, before the multiple-page capability was added. In 
those days, both programs framed a single page within a very similarly sized 
(within inches) pasteboard workspace. FreeHand’s page was placed at the 
lower left, and when resized, it grew toward the upper/right (Figure 5). The 
page in Illustrator was (and still is) placed in the middle of the Pasteboard, 
and when resized, it grew (grows) from the center out (Figure 6).

Figure 5  FreeHand’s Pasteboard is a little more than 
224 inches square. The default first page is near the 
lower-left corner. Pages grow upward and toward  
the right.

Figure 6  The pasteboard in Illustrator is a little more than 
227 inches square. The single artboard is in the center and 
grows from the center outward.
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Both programs conform to the math and engineering convention of having 
the zero point of its coordinate grid located at the lower-left corner of the 
page. Because the artboard (page) in Illustrator is always centered in the 
pasteboard, be sure to check the alignment of the ruler origin after changing 
the page size. Do this the same way you do it in FreeHand: double-click the 
ruler’s origin—the box where the left and top rulers meet at the upper left 
of the document window.

As for Illustrator’s single-page-per-document limitation, you will occasion-
ally encounter references to workarounds and/or plugins that invariably 
resort to either page tiling or using layers to imitate multiple pages.

Of course, FreeHand can also tile pages and show/hide layers, and the  
FreeHand user will find these workarounds quite unsatisfying substitutes 
for the real thing. To date, there is no real answer. Illustrator CS2 enhanced 
the tiling workaround by enabling page tiles to be saved as individual pages 
in a single PDF file (refer to Chapter 13, Saving and Exporting Files, in Real 
World Adobe Illustrator CS3).

Working with Rulers, Grids, and Guides
With Illustrator, you can choose between points, picas, inches, millimeters, 
centimeters, and pixels, and the value readouts in panels will change accord-
ingly the next time a selection causes them to update. But other scales avail-
able in FreeHand, such as decimal inches, are not offered in Illustrator, and 
you cannot create custom scales such as 1"=10' and have value fields reflect 
the scale accordingly.

The grid in Illustrator works similarly to FreeHand’s, but it offers the option 
for displaying it as lines of dots like FreeHand or as lines. A more significant 
difference is that the grid in Illustrator rotates with the Constrain Angle 
preference setting.

Guides are also similar to FreeHand’s, except that in FreeHand they extend 
across the page, whereas in Illustrator they extend to the bounds of the 
entire Pasteboard. As in FreeHand, Illustrator’s unlocked guides can be 
released (View > Guides > Release Guides) to turn them into ordinary 
paths, and ordinary paths can be turned into guides (View > Guides > 
Make Guides). One handy little difference between Illustrator’s guides and 
FreeHand’s is that in Illustrator they snap to your ruler tick marks if you 
press Shift, whether or not you have Snap to Grid on.

When opening a  
multiple-page  

FreeHand 10 or MX file in 
Illustrator CS3, you can 
choose to convert all pages  
to multiple crop areas. For 
more information on crop 
areas, refer to Chapter 1,  
The Illustrator Environment,  
in Real World Adobe Illustrator 
CS3 (Peachpit Press).

When opening a  
multiple-page  

FreeHand 10 or MX file in 
Illustrator CS3, you can 
choose to convert all pages  
to multiple crop areas. For 
more information on crop 
areas, refer to Chapter 1,  
The Illustrator Environment,  
in Real World Adobe Illustrator 
CS3 (Peachpit Press).
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Where’s the Inspector?
FreeHand’s Object panel (which many FreeHand users still refer to as the Object 
Inspector) is like a one-stop shop for information about and settings for the cur-
rent selection. The closest counterpart to this in Illustrator is the Appearance 
panel, and it is also probably the most important panel to have always handy.

The Appearance panel, like FreeHand’s Object panel, is where you find the 
stack of strokes, fills, and effects that are applied to the current selection. The 
Appearance panel also displays some specific information about the items in 
that stack; for example, the weight of a stroke appears within its listing.

Beyond that, however, the similarity begins to break down because of 
this important difference: although the Appearance panel in Illustrator is 
where you can view the stack of strokes, fills, and effects, it is not where 
you edit them and, in the case of effects, not where you apply them. You can 
add strokes and fills using the Appearance panel menu, but to adjust their 
parameters, you still must go to various other panels. As in FreeHand, you 
can apply effects to individual strokes or fills, but you select them from the 
Effects menu, not from the Appearance panel.

For example, consider a simple path with a basic appearance (one stroke, one 
fill). If this object is selected in FreeHand, the item stack lists the stroke and 
its weight. Likewise, if an identical object is selected in Illustrator, the stroke 
and its weight are listed.

However, in FreeHand, if you then select the stroke listing itself, all of its par-
ticular settings and options appear at the bottom of the Object panel. For exam-
ple, the stroke’s type, weight, cap, join, dash, arrowhead, and overprint settings 
appear, and they are editable right there in the Object panel (Figure 7).

This is not so in Illustrator, although the first step is similar. To modify that 
stroke’s options in Illustrator, you first select its listing in the Appearance 
panel. But to change its weight, dash, caps, and joins, you must still visit 

Figure 7  In FreeHand, the 
settings for the selected 
object’s attributes are pre-
sented in the bottom of the 
Object panel as contextual 
screens that display accord-
ing to which item in the 
attributes stack is selected. 
All four of these screens are 
displayed at the bottom of 
the single Object panel.

Figure 7  In FreeHand, the 
settings for the selected 
object’s attributes are pre-
sented in the bottom of the 
Object panel as contextual 
screens that display accord-
ing to which item in the 
attributes stack is selected. 
All four of these screens are 
displayed at the bottom of 
the single Object panel.
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Moving from FreeHand to Illustrator10

the separate Stroke panel. To apply an arrowhead to it, you call up the Add 
Arrowheads dialog from the Effects menu; to set it to overprint, you visit 
another separate panel named Attributes; to turn the stroke into a brush, 
you visit the Brush panel; and so on (Figure 8).

So although the Appearance panel is one that you need to keep up front and 
handy as you work, it is not at all the kind of comprehensive centralized 
object settings panel to which you are accustomed in FreeHand. Hunting 
around for specific settings is one of the primary causes for disorientation 
among FreeHand users when working in Illustrator. You have to get back 
into the mind-set of individual panels for each type of setting, which was 
more the nature of FreeHand’s early versions prior to the arrival of the 
Inspector-based interface.

You might logically expect Illustrator’s Control panel to be the centralized 
counterpart to FreeHand’s Object panel. Although it does provide more 
immediately convenient access to some of the most frequently needed set-
tings, it doesn’t necessarily present them all.

By the Numbers

Value fields in FreeHand panels and dialogs accept and retain numerical values to six decimal places, whereas 
Illustrator displays four. Under the hood, every measure in Illustrator is converted from its underlying native 
measure of 72 points per inch. This, combined with the four-decimal display, often leads to what the FreeHand 
user sees as disconcerting numerical inaccuracies in value fields. For example, if like many users you’ve memo-
rized the decimal equivalent of 1/16th as .0625 and then you enter .0625/2 in a value field, the displayed 
result will be .0313, not .03125. This does not mean that Illustrator did not make your object .03125 in width. It 
rounded the value only for the sake of the display in the panel. However (and unfortunately), if you then enter 
*2 after the displayed value to double the object’s measure, Illustrator recalculates the entire expression, which 
is now keyed into the field, with a result of .0626, instead of restoring the previous .0625. Does a thousandths-
of-an-inch inaccuracy matter? You decide.

Figure 8  Although the 
Appearance panel in 
Illustrator is similar to the 
Object panel in FreeHand 
in that it provides a stack 
of strokes, fills, and effects 
and displays some of their 
settings, and although the 
detail settings are sensitive 
to which item is selected in 
the stack, the actual settings 
reside in individual separate 
panels. Ready access to all 
of these panels is neces-
sary in order to make all the 
settings represented in the 
previous view of FreeHand’s 
Object panel.

Figure 8  Although the 
Appearance panel in 
Illustrator is similar to the 
Object panel in FreeHand 
in that it provides a stack 
of strokes, fills, and effects 
and displays some of their 
settings, and although the 
detail settings are sensitive 
to which item is selected in 
the stack, the actual settings 
reside in individual separate 
panels. Ready access to all 
of these panels is neces-
sary in order to make all the 
settings represented in the 
previous view of FreeHand’s 
Object panel.
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Walk This Way: Working  
with Objects
Differences exist between the way FreeHand and Illustrator let you know 
what is selected, and this can be quite disorienting. In FreeHand, the edges 
and points of selected simple paths display. All other objects, such as groups, 
compound paths, live special shape objects (ellipses, rectangles, and so on), 
blends, and clip paths display four corner handles of their bounding boxes 
when selected in their entirety. These handles are usually used to scale the 
object by dragging.

Illustrator highlights selected simple paths in the same fashion. But that’s 
also how they display regardless of whether they are part of a group, 
whether they are part of a compound path, or even whether they are masked 
by a clipping path.

This is particularly disconcerting in regard to clipping paths because the 
edges of the entire clipped contents display, not just the portions inside the 
clipping paths (Figure 9).

In Illustrator, you can choose View > Hide Edges when you need to reduce 
the visual clutter (for example, text objects converted to paths easily become 
an indistinguishable mass of displayed points). Be aware, however, that if 

Figure 9  Complex objects, 
such as compound paths, 
clipping paths, and groups, 
highlight the edges of their 
subparts or contents when 
selected. It takes a little get-
ting used to.

Figure 9  Complex objects, 
such as compound paths, 
clipping paths, and groups, 
highlight the edges of their 
subparts or contents when 
selected. It takes a little get-
ting used to.
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Moving from FreeHand to Illustrator12

you have Hide Edges on, the selection is not displayed at all if you are work-
ing with the Direct Selection tool, because the bounding boxes in Illustrator 
do not display when working with that tool. Even when you’re working 
with the regular Selection tool, looks can be quite deceiving as to what is 
actually selected because the bounding box displays around the entire selec-
tion, not each object. Therefore, use the Hide Edges command only for 
momentary toggle on/toggle off purposes, not as a normal working mode.

Using Marquee Selections
Generally speaking, when you drag with FreeHand’s pointer, it selects what-
ever you fully enclose with its dashed-line selection marquee. The Selection 
tool in Illustrator, on the other hand, selects whatever its selection marquee 
touches—even objects that partially fall within the marquee area—and this 
takes considerable practice. Which is best? That depends upon the specific 
circumstances (you could have guessed that).

Actually, upon closer examination, the comparison here is not really all 
that simple. For example, if you drag a selection marquee using Illustrator’s 
Direct Selection tool (the white-filled pointer), its behavior is similar to 
that of FreeHand’s pointer when it is dragged across several simple paths. 
In both cases, the paths become highlighted, but only the points that were 
enclosed become selected.

Similar, of course, does not mean identical: dragging across only segments 
of simple paths (but enclosing no points) with FreeHand’s pointer selects 
nothing. The same is true of FreeHand’s Subselect tool. In contrast, with 
Illustrator, the same action of dragging across segments selects the whole 
path(s) with the Selection tool and selects the crossed-over segments with 
the Direct Selection or Lasso tool.

So, here we have a situation in which neither of FreeHand’s tools select  
anything; yet both of Illustrator’s “corresponding” tools select something. No 
wonder users feel like astronauts on a foreign planet when learning the 
“other” program.

A typical situation in which this difference is particularly bothersome is 
when you’re trying to lasso a few points of paths that overlap other paths. 
Remember, the selection marquees in Illustrator select whatever they touch. 
Well, in both Illustrator and FreeHand (these days), a segment is a selectable 

It’s best to get this 
selection behavior 

mentally nailed down before 
you progress very far into 
work with Illustrator. Spend a 
little time drawing some sim-
ple shapes, dragging across 
them with both selection 
pointers, and trying to antici-
pate what will be selected 
when you release the mouse 
button.

It’s best to get this 
selection behavior 

mentally nailed down before 
you progress very far into 
work with Illustrator. Spend a 
little time drawing some sim-
ple shapes, dragging across 
them with both selection 
pointers, and trying to antici-
pate what will be selected 
when you release the mouse 
button.
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item. So in FreeHand, you can lasso the cluster of points without also select-
ing the overlapping path. That is, crossing over segments of the unwanted 
path does not select them, because the segments are not fully enclosed by 
the marquee; you just have to be careful not to fully enclose any points of 
the unwanted path.

This is not the case in Illustrator. If you have to cross over a segment of an 
unwanted path in order to select points in its interior, doing so selects the 
unwanted path’s segment, which is touched by the marquee. At first, the 
FreeHand user is inclined to think that Illustrator wants to select segments 
more than FreeHand does. But the real principle at play here is Illustrator’s 
convention of selecting whatever a selection marquee touches.

Applying Transformations
Illustrator provides a collection of transform tools similar to those in  
FreeHand. However, their basic use differs. In FreeHand, the invisible  
center of transformation is normally set where you first click with the tool. 
You then drag away from this point to transform the current selection.

In Illustrator, when you select a transform tool, the origin point is at the 
center of the selection, and it is a visible icon that you can move to where 
you want it. After you position the origin point, you can click and drag away 
from it to transform the selection. Initially, the FreeHand user can find this 
difficult to control for two reasons:

•	 The FreeHand user wants to habitually click with the transformation 
tool and immediately start dragging. You can do this in Illustrator, but if 
you do, the transformation will be centered wherever the origin marker 
is—at the center of the selection when you first select the tool. Instead, 
after selecting the desired transform tool, click where you want the 
transformation centered. Then move the pointer some distance from 
the marker and begin your drag.

•	 In Illustrator, the rate at which the transformation occurs is propor-
tional to the nearness of your pointer to the transformation origin when 
you begin the drag. Therefore, you have finer control over the amount 
of the transformation if you begin your drag some distance from the 
position of the origin marker. The principle is similar to FreeHand’s 
Rotation tool, with which a temporary guide appears when you click. 

Walk This Way: Working with Objects 13
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Moving from FreeHand to Illustrator14

If you drag along this guide before beginning your rotation, you have 
finer control. The difference is that this principle works similarly on all 
of Illustrator’s transformation tools, not just the Rotate tool.

You can use Illustrator’s Effect > Distort & Transform > Transform effect 
to replicate the behavior of FreeHand’s Mirror Xtra. Because this is an 
effect, the result remains editable until it is nailed down into individual 
objects by choosing Object > Expand Appearance. Also, be sure to explore 
the Transform Each command in Object > Transform > Transform Each, 
described in Chapter 4, Advanced Vectors (Real World Adobe Illustrator CS3).

Working with Text Objects
Unlike FreeHand, Illustrator has two separate object types for text objects 
that autoexpand horizontally and those that wrap. A Point Type object is 
similar to a FreeHand text object that is set to autoexpand, and you usually 
create it in the same way—simply click (don’t drag) with the Type tool.

An Area Type object is one that is contained within a frame, similar to a 
FreeHand text object that is not set to autoexpand in either direction. Again, 
the customary creation routine is the same—drag with the Type tool.

For the full rundown on text handling, see Chapter 7, Typography (Real 
World Adobe Illustrator CS3), but here are a few specifics that commonly 
befuddle FreeHand users:

•	 In Illustrator, you can’t set an Area Type object to autoexpand vertically. 
You have to become especially careful by looking for the red text over-
flow icon.

•	 There is no explicit command for separating path type from its path 
once it has been attached. You can copy the text and paste it into an 
ordinary text object, or you can use the Direct Selection tool to select 
and modify the path. However, if you delete it, you will delete the 
whole Path Type object.

•	 For type on a path, FreeHand’s feature by which a return character 
wraps the following text to the opposite side of the path is unique to 
FreeHand. There is no corresponding feature in Illustrator. Creating the 
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common text-around-the-top-and-bottom of a circle treatment requires 
two Type on a Path objects (Figure 10).

Combining Paths (Pathfinders)
Be sure to explore carefully and methodically the pathfinder features in 
Illustrator. These are analogous to FreeHand’s Modify > Combine opera-
tions, but you will find many unfamiliar behaviors within them.

In Illustrator, some pathfinder operations result in compound shapes, which 
can be nondestructively edited until they are “expanded” into literal new 
paths. In the Pathfinder panel, these are the four in the top row of icons. 
Ironically, despite their “live” nature, these are among the functions that will 
feel most familiar. The behaviors of the first three (Add, Subtract, Inter-
sect) pretty much correspond to FreeHand’s Union, Punch, and Intersect 
commands. The fourth (Exclude) results in something similar to what you 
achieve in FreeHand when you join several paths into a composite, where 
overlapping areas become voids.

You will no doubt find some of the other pathfinders to be less intuitive 
in the details of their results. Several remove strokes and/or unfilled open 
paths in the process of performing their shape combinations. For example, 
Illustrator’s Divide behaves similarly to FreeHand’s Divide if at least some 
of the paths are closed. However, Illustrator’s Divide creates closed paths 
around areas surrounded by open paths, whereas FreeHand’s Divide is not 

Figure 10  Illustrator dis-
tinguishes between Area 
Type objects, which do not 
autoexpand, and Point Type 
objects, which do. These 
two cannot be directly 
turned into one another by 
changing their autoexpand 
characteristics as is done in 
FreeHand. Path Type objects 
are much like FreeHand Text 
on a Path objects. There are 
separate tools for all three 
(plus the vertically oriented 
versions of area and point 
text). But you can create all 
three objects (Point Type, 
Area Type, and Path Type) 
with the regular Type tool.

Figure 10  Illustrator dis-
tinguishes between Area 
Type objects, which do not 
autoexpand, and Point Type 
objects, which do. These 
two cannot be directly 
turned into one another by 
changing their autoexpand 
characteristics as is done in 
FreeHand. Path Type objects 
are much like FreeHand Text 
on a Path objects. There are 
separate tools for all three 
(plus the vertically oriented 
versions of area and point 
text). But you can create all 
three objects (Point Type, 
Area Type, and Path Type) 
with the regular Type tool.
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available to selections of only open paths. This can be an often advantageous 
difference (Figure 11).

The Merge pathfinder in Illustrator also behaves somewhat similarly to 
FreeHand’s Divide, but it deletes strokes and leaves the selection unaf-
fected if none of the paths is filled (closed or not). But it also does more, 
and Merge is one of the pathfinders that gives the FreeHand user new and 
important capabilities. It removes underlying parts of overlapping fills and 
simultaneously welds areas of contiguous color (Figure 12).

Figure 11  FreeHand’s 
Combine > Divide com-
mand does nothing with 
this object because there 
are no closed paths (left). In 
contrast, Illustrator’s Divide 
creates closed paths around 
visually enclosed areas 
resulting in paths you can 
quickly stroke and fill (right).

Figure 11  FreeHand’s 
Combine > Divide com-
mand does nothing with 
this object because there 
are no closed paths (left). In 
contrast, Illustrator’s Divide 
creates closed paths around 
visually enclosed areas 
resulting in paths you can 
quickly stroke and fill (right).

Figure 12  Illustrator’s 
Merge pathfinder can 
remove the overlaps and 
weld the areas of contigu-
ous color, quickly resulting 
in paths more suitable for 
practical purposes such as 
cutting from sign vinyl.

Figure 12  Illustrator’s 
Merge pathfinder can 
remove the overlaps and 
weld the areas of contigu-
ous color, quickly resulting 
in paths more suitable for 
practical purposes such as 
cutting from sign vinyl.
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The bottom line here is for the FreeHand user to just be aware. Pathfinders 
are indeed intended for the same general purposes as FreeHand’s Combine 
operations, but the devil is in the details. The differences are too numerous 
and dependent upon specific circumstances for an exhaustive comparison. 
Be sure to give Chapter 4, Advanced Vectors (Real World Adobe Illustrator CS3), 
a thorough study, and set up simple experiments in which you try to antici-
pate the results. You’ll not only avoid a lot of unexpected confusion, but 
you’ll also find a few “new” gems that you can employ to your advantage 
with a little ingenuity.

Working with Composite Paths  
(Compound Paths)
A FreeHand composite path is functionally the same as an Illustrator com-
pound path, with one rather shocking difference: the individual paths of an 
Illustrator compound path do not have to be closed. That’s right. Draw two 
curved open paths with a stroke but no fill. Select them both, and choose 
Object > Compound Path > Make. Now use the Direct Selection tool to 
select and apply a fill to one of the paths. Both curves receive the same fill, 
because they are, in fact, a single compound path.

FreeHand users may find it initially distracting and occasionally confusing 
that Illustrator displays the edges of all the subpaths of a selected compound 
path. Sometimes this makes it difficult for you to recognize that a selected 
path is part of a compound path. You see, in FreeHand, you typically click 
a composite path to select it, and seeing its four corner handles clues you in 
to that it is a composite or a group. You then deliberately hold down Option 
(Alt) and click to “dig into” the composite and select one of its subpaths. In 
Illustrator, though, you will more often be using the Direct Selection tool. 
When you click a compound path, the Direct Selection tool goes ahead and 
selects the subpath, and therefore you may not realize that it is compounded 
with other paths.

Another related oddity worth mentioning here is that certain features that 
FreeHand users would associate only with open paths, such as arrowheads, 
also apply to closed paths in Illustrator. You are probably aware that even 
a closed path still has a direction and a start/end point. But if you apply 
an arrowhead to a closed path in FreeHand, the arrowhead doesn’t appear 
unless the path is cut or opened. This is not the case in Illustrator; the 
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arrowhead appears at the start/end point of the closed path and on each  
subpath of a compound path.

Healthy Jogging: Drawing and 
Editing Paths
As in FreeHand, productive and efficient drawing with the Pen tool in Illus-
trator involves frequent movements of anchor points and direction handles 
as you proceed. And this is where the FreeHand user stumbles. Surprisingly, 
the stumbling block is not so much due to Pen tool differences but more 
because of Illustrator’s fundamentally different approaches toward tools, the 
simple matter of selection, and the definitions of parts of a path.

Proficient FreeHand users draw paths efficiently by repeatedly switching 
back and forth between two basic operations: adding segments with the Pen 
tool, and adjusting the paths, segments, points, and handles with a selection 
tool. This oft-repeated process involves the Pen and the Pointer.

Proficient Illustrator users do the same—alternately adding segments and 
selecting subparts of the path—but doing so involves more tools. Depend-
ing upon the habits you develop in Illustrator, it can involve the Pen, Selec-
tion, Direct Selection, Group Selection, and Convert Anchor Point tools.

In addition to dealing with the more numerous individual tools in  
Illustrator, the FreeHand user must simultaneously adapt to a reversal of 
“selection direction” as he manipulates paths and their subparts. As we’ll 
see, for a number of reasons intrinsic to the principles of its interface,  
Illustrator’s path selection moves generally from deeper to shallower (or, 
specific to general) as opposed to FreeHand’s shallower to deeper (general  
to specific) approach.

Furthermore, the common selection routines in Illustrator are described as 
more segment oriented whereas FreeHand’s are more decidedly points ori-
ented. To the FreeHand-accustomed user, it is much like learning to drive 
a manual transmission and to back a trailer at the same time. Understandably, 
it is at first a very disorienting endeavor, requiring conscious effort with 
every turn of the wheel and every slip of the clutch. But after a little stud-
ied practice at a few narrow boat ramps, it becomes a natural mind shift. 
Let’s examine these underlying differences more closely to help you avoid 
launching your car into the lake.
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Using Multiple Tools, Not Multiple Clicks
You’ve heard it said (and probably said it yourself) for years: FreeHand does 
with one selection tool what Illustrator requires two to do. We wish it were 
that simple. If you take nothing else away from this discussion, be sure to 
get this one down pat: Illustrator does with individual tools what FreeHand 
does with consecutive clicks of a single tool. This deceptively subtle difference 
is at the very core of much of the frustration and confusion you feel while 
drawing paths in Illustrator.

In FreeHand, consecutive clicks on the same part of a path with the same 
selection tool dig deeper, enabling you to manipulate the path’s subparts. For 
example, the first click of the Pointer directly on a segment of an unselected 
path selects the path. Another click selects the segment (Figure 13).

This does not occur in Illustrator. A tool change—whether you make it by 
actually picking a different tool or by momentarily invoking it with a modi-
fier key—is required to select at a different “object depth.” The net result  
is that drawing paths with the Pen tool in Illustrator involves more tools 
(Figure 14).

Here’s a little history: From its beginning, and for most of its years, Free-
Hand had but one selection tool (the black Pointer). To select a path, you 
clicked it with the Pointer. Then, to select a point on that path, you clicked 
again on the point. Then, to select a retracted handle “within” that point, 

Figure 13  In FreeHand, click 
once with the Pointer to 
select the path; click again 
to subselect a point.

Figure 13  In FreeHand, click 
once with the Pointer to 
select the path; click again 
to subselect a point.

Figure 14  In Illustrator, 
the Direct Selection tool 
goes right to the point (or 
segment, depending on 
where you clicked the path). 
You can click all day long 
with the black Selection 
tool, but it will never direct 
select a subpart of the path. 
(Modifier keys can switch 
you to the other pointer, but 
we’ll get into that later.)

Figure 14  In Illustrator, 
the Direct Selection tool 
goes right to the point (or 
segment, depending on 
where you clicked the path). 
You can click all day long 
with the black Selection 
tool, but it will never direct 
select a subpart of the path. 
(Modifier keys can switch 
you to the other pointer, but 
we’ll get into that later.)
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you pressed Option (Alt) to tell the pointer to “dig deeper still,” and then 
you simply dragged it out. (If both handles were retracted, the first one 
dragged out was the outgoing handle; this was followed by the incoming 
handle if you dragged again.)

Meanwhile, Illustrator had its two pointers: the “normal” black-filled  
Selection tool was primarily for selecting whole objects and their bounding 
boxes. The white-filled Direct Selection tool was primarily for selecting the 
subparts of paths—points and segments.

Then, in version 9, FreeHand acquired its own hollow pointer, the Subselect 
tool. This was a direct accommodation to the habits and expectations of 
Illustrator users. But there was a fundamental difference. FreeHand’s Subse-
lect tool did not actually add any functionality. Anything that it could select 
could still be just as easily selected with the original black Pointer, and most 
experienced FreeHand users simply ignored the new tool (and most still do 
to this day). In still later versions of FreeHand, certain esoteric responsibili-
ties have been assigned to the Subselect tool to help it earn its keep (having 
to do with new features, such as the special control handles of the live basic 
shape objects). This is a quite recent development, and we dare say that all 
but newcomers to FreeHand still ignore the Subselect tool except for those 
new feature purposes. And regardless, the fact remains that both the Pointer 
and Subselect tools in FreeHand can select all parts of a path—segments, 
points, or handles.

The salient point here is this: while you are drawing paths in FreeHand,  
you need only one selection tool working in conjunction with the Pen. In 
Illustrator, that is not so. This in turn involves the memorization of more 
(and more complicated) keyboard shortcuts to switch between the more 
numerous tools.

You will hear some long-time Illustrator users claim to rely entirely upon 
Illustrator’s Direct Selection tool and to absolutely never ever use the “nor-
mal” black one. That may or may not be true, but the fact is, if you use only 
the Direct Selection tool in Illustrator, you’ll sacrifice certain very common 
selection conveniences (such as those associated with bounding box–related 
manipulations). And if you do ever use the black Selection tool, its mere 
existence can get in the way while you are drawing paths. Further compli-
cating matters, a third “selection” tool is required for accessing retracted 
handles, as we shall examine momentarily.
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“Soft” Mode Change vs. “Hard” Tool Switch
You may remember that when FreeHand acquired its Subselect pointer, the 
various cursor icons were shuffled, too. The long-established Option (Alt) 
keyboard modifier of the Pointer now changes the pointer to that of the 
newfangled Subselect pointer. But this is a fairly recent development, and 
it represents only a visual change, not a functional one. Because the actual 
behavior is the same as before the extra pointer appeared, many, if not most, 
FreeHand users still think of the Option (Alt) modifier as a momentary 
mode change of the current tool (reinforced by the fact that the same key is 
used to make similar mode changes for other tools), not as a hard switch to 
an entirely different tool.

In Illustrator, although some of the modifier key presses are indeed momen-
tary, both the general interface and the facts of the matter just discussed 
result in the opposite sensation. The user impression is more often that 
of making an actual switch to a different tool. The FreeHand user new to 
Illustrator struggles with reconciling this difference when a behavior he is 
trying to understand as a mode change turns out to be an actual change  
of tools.

Performing “Bottoms-Up” Selection
Press the Direct Selection tool in Illustrator’s main Toolbox to extend its 
flyout panel, and you’ll see another one with a plus sign (+) next to it.  
That’s the Group Selection tool. As we’ve seen, pressing Option (Alt) when 
Illustrator’s Direct Selection tool is in hand does not invoke the Convert 
Anchor Point tool to allow you to dig deeper and drag out a handle. Instead, 
pressing Option (Alt) momentarily switches to that mysterious third 
pointer, the Group Selection tool, which digs shallower, not deeper. That  
is, it selects the whole path.

Note that the same modifier key, Option (Alt), is used in both FreeHand 
and Illustrator to change the depth of the primary selection tool. But as 
we’ve now seen, the depth change is in opposite directions. Add to this what 
we now know about Illustrator’s two pointers. For most FreeHand users, 
the primary selection pointer is the black one. For most intermediate and 
advanced Illustrator users, the primary selection tool is the hollow one.

Healthy Jogging: Drawing and Editing Paths 21
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This is of much greater significance than merely the color of the pointer. In 
practice, it translates to this: In FreeHand, the customary selection routine 
starts with the black pointer in hand, and subsequent clicks, sometimes aug-
mented with modifier keys, generally progress from general to specific (object 
to path to point to handle). In Illustrator, the more common “advanced” 
selection routine starts with the Direct Pointer in hand. As soon as you 
make the first click with this tool on a path at which you are already at the 
deepest level, the point or the segment you clicked is selected. Sequential 
clicks using modifier keys, progress from specific to general (point or segment 
to path to group). Note that this is different even from the behavior of  
FreeHand’s Illustratorish Subselect pointer. The first click of an unselected 
path with FreeHand’s white pointer does not subselect the segment; you 
click again to do that.

So to review, how do you select a whole path when you have the Direct 
Selection tool in hand? Press Option (Alt), and click the path. This momen-
tarily invokes the Group Selection tool, telling Illustrator to select up a level 
to the whole path. In fact, if the path happens to be part of a group or a 
compound path, another click with the Group Selection tool selects up to 
the group or compound object level.

Understanding Path Handling Conventions
Here is a list of some of the behavioral differences you’ll encounter. Some 
are conceptually puzzling at first, and these we will explore more fully 
shortly. Others are merely differences in interface conventions:

•	 Selected points in Illustrator are displayed as solid; unselected points are 
displayed as hollow—exactly the opposite of the default in FreeHand. 
However, in both programs, if a whole path is selected, and none of its 
points is selected, then all points are displayed as solid. (In this detail, 
Illustrator’s convention seems more logically consistent.)

•	 FreeHand displays selected corner points as hollow squares and selected 
curve points as hollow circles. Illustrator displays both curve and corner 
points identically; there is no visual clue as to the type of point selected 
other than the orientation of its handles.

•	 A double-click of the Pen does not end a path in Illustrator. To end the 
current path, you have to deselect it (or click to close the path). Press the 
Command (Control) key to momentarily invoke a Selection tool, and 

Illustrator CS3 also  
features a new behav-

ior that allows you to select a 
specific anchor point with the 
Direct Selection tool even if 
the entire object is already 
selected.

Illustrator CS3 also  
features a new behav-

ior that allows you to select a 
specific anchor point with the 
Direct Selection tool even if 
the entire object is already 
selected.
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click the page in a nonobject location; or press the keyboard shortcut for 
Deselect, which is Command-Shift-A (Control-Shift-A).

•	 In Illustrator, pressing Delete when a point is selected does not merely 
remove the point; it removes the point and its associated segment(s). There-
fore, if you select one point of a closed path and press Delete, you delete 
the point and the two segments on each side of it, resulting in an open 
path. If you select a point of an open path and the point is not an end 
point, pressing Delete deletes the point and the two adjacent segments 
and results in two separate paths. If the point you deleted happened to 
be only one segment removed from an end point of the path, you still 
have two separate paths even though the segment next to the end point 
is removed. The end point itself is left behind as a “stray point”; this 
behavior is why Illustrator is much more susceptible to the stray point 
malady than is FreeHand.

•	 In Illustrator, if you select a point and copy it to the clipboard, not only 
is the point copied, but also its associated segments are copied. This can 
be useful. For example, selecting the bottom point of an ellipse is a fre-
quently used method to begin drawing a cylinder. Making this kind of 
selection, followed by Cut and then Paste in Front, is also a commonly 
used method for cutting a path.

•	 When clicked on a segment of an unselected path, the Direct Selection 
tool selects the segment, not the whole path. (Remember, bottom-
up selection.) If the segment has at least one of its associated handles 
extended, those handles display, letting you know you have selected the 
segment. However, if the selected segment has both of its associated 
handles retracted (it is a straight segment), there is no visual indication that 
the segment is selected. Dragging the segment moves it and its associ-
ated points, even though the two points are not displayed as selected. 
If such a selected segment has either of its handles extended, however, 
dragging it bends the segment. Its associated points do not move, but 
the extended handle(s) will.

•	 Subselecting a segment in FreeHand automatically selects its associated 
points. But in Illustrator, direct selecting a segment selects only that 
segment’s handles.

By now it should be abundantly clear that, despite that Illustrator and  
FreeHand create and manipulate the same kinds of paths and that corre-
sponding tools and commands (often even with the same names) can  
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be found, performing even the most common tasks can require quite differ-
ent thought processes. Clearly, the conventional wisdom approach of merely 
searching for and locating corresponding tools is not the path to Illustrator 
proficiency but to Illustrator frustration. When a command as basic as press-
ing the Delete key yields such radically different results, the feature-by-
feature details of it all are too numerous to memorize by rote. You have to 
concentrate on discovering Illustrator’s different set of underlying principles 
and learn to think the way Illustrator does.

Whenever you encounter one of those frustratingly unexpected results, take 
a moment to move over to the side of the artboard, draw a simple path, and 
perform the operation on it until you understand what is happening. Taking 
a little time to do that pays off big.

Deleting and Adding Points

As we’ve seen, merely selecting a point and pressing Delete does not delete 
just the point but its associated segment(s) as well. Consequently, Illustrator 
does not provide a way to eliminate a bunch of selected points at once with-
out simultaneously breaking the paths by removing segments.

Similar to FreeHand, Illustrator Pen tool has an autoadd and autodelete 
behavior. Unlike Freehand, and in keeping with Illustrator’s propensity 
toward tools, tools, and more tools, the cursor icons that appear when  
you’re using this feature are actual separate tools—the Add Anchor Point 
tool and the Delete Anchor Point tool live in their own slots in the Pen 
tool’s cluster in the main Toolbox.

When the autoadd and autodelete setting is on, it affects only selected 
paths—usually the one you are drawing at the time. If several paths are 
selected, adding or deleting a point on one deselects the other paths.

Merging Paths

You’ve drawn an open path with the Pen and deselected it in order to start 
a new path, which you know will have a different stroke weight, color, or 
other attribute. You want the new path to snap to and begin at the same 
place where one of the preexisting paths starts or ends. When you click, 
Illustrator assumes that—even though the preexisting path is not selected—
you don’t mean to start a new path, but you want to continue adding seg-
ments to the existing one.

Illustrator CS3 does 
offer the ability to 

delete selected anchor points 
from a path without deleting 
the segments through a  
button that appears in the 
Control panel.

Illustrator CS3 does 
offer the ability to 

delete selected anchor points 
from a path without deleting 
the segments through a  
button that appears in the 
Control panel.
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Illustrator provides a clumsy workaround for this. To prevent this dyslexic 
mind-reading behavior of the Pen, click and hold the mouse button down 
somewhere beyond the snap distance of the preexisting path’s end, press the 
spacebar, drag the cursor to the end point, and only then release the mouse 
button. Then continue placing the points of your new path.

Joining and Closing Paths

Inexplicably, after all these years, Illustrator still does not allow you to select 
a bunch of open paths and issue a Join command to connect them end to 
end. To join paths in Illustrator, you must direct select the end points to tell 
Illustrator which ends of the paths you want connected, and you must do 
this two points at a time.

This can be very tedious. Often, if the two ends you are trying to join are 
in close proximity, dragging a selection marquee around the end points is 
easier than Shift-clicking them individually. However, if there are addi-
tional points near either of the end points, you will direct select them also, 
and the Join command will fail with an annoying dialog. (Check the Don’t 
Show Again button, and thereafter you’ll just get a system beep when a Join 
command doesn’t work.) Illustrator’s Join command is also used to close an 
open path, but again, it works on only one path at a time.

Selecting Through Objects

Illustrator provides no less than three ways to select objects underneath 
others, and unfortunately none of them works as quickly or simply as 
FreeHand’s keyboard modifier that allows you to cycle through the objects 
under the cursor.

In Illustrator, Control-click (right-click) to invoke the contextual menu, and 
you’ll find options for Select Next Item Above/Below. Similar commands 
are in the Select menu and are available as keyboard shortcuts.

Cutting Paths

Illustrator’s Knife tool (it’s grouped with the Scissors tool) works much like 
FreeHand’s (drag for free-form cuts; Option [Alt] drag for straight cuts) 
with one crippling exception: it fails to cut open unfilled paths. This makes 
it useless for common tasks such as neatly trimming off a bunch of roads 

Mentioned in Chapter 
4, Advanced Vectors 

(Real World Adobe Illustrator 
CS3), Rick Johnson’s Concate-
nate plugin allows you to join 
multiple paths at once in  
Illustrator.

Mentioned in Chapter 
4, Advanced Vectors 

(Real World Adobe Illustrator 
CS3), Rick Johnson’s Concate-
nate plugin allows you to join 
multiple paths at once in  
Illustrator.
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at the border of a map. For cutting open unfilled paths, you must resort to 
other means, such as tediously clicking each path with the Scissors tool.

Note that the failure affects unfilled open paths. This is initially confusing 
to FreeHand users because the Knife tool will indeed cut across an open 
path if it is filled, and as we’ve already noted, Illustrator allows open paths to 
have fills, contrary to most FreeHand experience.

Also, be careful not to confuse the Knife tool with the Slice tool, which is 
used for making image slices for optimizing Web-based images. The Slice 
tool icon looks more like an X-acto knife.

Cloning

There is no explicit clone command in Illustrator. Illustrator users typi-
cally use Copy, followed by Command-F (Control-F) for Paste in Front 
or Command-B (Control-B) for Paste in Back for this purpose. Doing this 
by means of the keyboard shortcuts makes it reasonably quick and easy, 
though, so it’s really not as serious an omission.

Reversing

FreeHand users are accustomed to being able to reverse the direction of any 
path or subpath at any time by choosing the Modify > Alter Path > Reverse 
Path command. Illustrator has a pair of Reverse Path buttons in the Attri-
butes panel, but these work only on closed subpaths of compound paths. To 
reverse open paths or subpaths, most users just click the start end with the 
Pen tool. The autojoin behavior of the Pen thinks you want to start adding 
segments from that end point and therefore reverses the path. Of course, 
this means having to reverse each path individually; you can’t reverse several 
paths at once, as FreeHand’s command can.

Bungee Jumping: Entering a  
Sea of New Functionality
If the previous section was “the bad,” there is also a middle ground. Some 
features in Illustrator both delight and disappoint the FreeHand user at the 
same time. Some are bittersweet and fall short of a FreeHand user’s expec-
tations in some ways and yet also contain certain aspects that are better than 
what the user is accustomed to.

Illustrator CS3 offers a 
new Eraser tool, which 

allows you to delete or cut 
paths, although it isn’t any-
thing like a knife tool and 
can’t be used for precisely 
cutting paths. Refer to Chap-
ter 4, Advanced Vectors (Real 
World Adobe Illustrator CS3), 
for more information about 
this new tool.
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Of course, just as FreeHand has many taken-for-granted “minor” features 
that make major differences in efficiency and capability, so does Illustrator. 
These are wonderful surprises that reward the FreeHand user who takes the 
time to explore their potential.

Aligning and Distributing Objects
In Illustrator, locked objects are not selectable. This means they cannot be 
used as anchors to which you can align other objects. But when performing 
alignments in Illustrator, you can designate one of the selected objects as the 
anchor by simply giving it an extra click before performing the alignment 
(refer to Chapter 4, Advanced Vectors (Real World Adobe Illustrator CS3), for 
more about defining key objects). Illustrator also allows you to apply Align 
functions to individually selected anchor points.

The sweet part is the additional functionality of Illustrator’s Align panel, 
especially the Distribute options, which are shown when you select Show 
Options from the panel flyout. Unlike in FreeHand, you can specify a dis-
tance between distributed objects. For example, if you want a series of differ-
ent-sized objects to neatly abut, just enter 0 in the Distribute Spacing field.

Employing Round Corners
How often have you performed the goofy positive/negative inset path  
trick in FreeHand to round the corners of a path? Illustrator has a Round 
Corners command that you can apply as either a literal filter (Filter > 
Stylize > Round Corners) or as a live effect (Effect > Stylize > Round 
Corners). However, it doesn’t actually give you corners of the radius you 
specify; the value you enter is actually the distance from the corner at which 
the curve is begun. Also, it works on whole paths, not on specific selected 
points. Still, this should be a welcome feature to FreeHand users.

Expanding Strokes
As in FreeHand, Illustrator provides a means by which you can outline  
the edges of a stroke with unstroked paths, thereby converting them to 
closed, filled, and unstroked paths. Illustrator’s counterpart to FreeHand’s 
Modify > Alter Path > Expand Stroke command is its Object > Path > 
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Outline Stroke command. (The functionality also resides as a check box in 
the Object > Expand dialog.)

Illustrator’s version of this important command holds a fundamental advan-
tage over FreeHand’s: whereas FreeHand’s version invokes a dialog in which 
you specify the thickness, caps, and joins of the expanded strokes, Illustra-
tor’s abides by the already-applied characteristics of each path individually.

Besides just being more intuitive and “sensible,” Illustrator’s behavior is also 
more versatile. For example, if you have a line drawing in which several dif-
ferent stroke weights and caps are used, you can turn the entire thing into 
closed paths in one whack, without giving all the lines the same treatment. 
An example of where this can be especially useful is in preparing artwork 
for sign vinyl–cutting equipment. Applying Illustrator’s Outline stroke,  
followed by the Merge pathfinder, performs much of the necessary prepara-
tory work.

Automating with Illustrator
Appendix A, Automation with Illustrator (Real World Adobe Illustrator CS3), is 
devoted entirely to working faster and more efficiently with Illustrator, but 
it’s important to emphasize here that Illustrator supports both AppleScript 
on the Mac and Visual Basic scripting on Windows. More important, there’s 
the cross-platform JavaScript support as well. Adobe has similar built-in 
scripting support for all of its applications (including Bridge), so what you 
learn by scripting in one program augments your efforts in another.

If scripting just isn’t for you, you can still create your own custom features 
by stringing together very simple or quite complex sequences of operations 
in Illustrator’s built-in macro feature, the Actions panel. Many useful exam-
ples are provided with the program for common tasks, but you can also 
build your own specialties; for example, you can perform a series of Expand 
and Pathfinder operations to prepare artwork for your own sign-cutting 
workflow, or you can scale and rotate objects to fit the top, left, and right 
planes of an isometric drawing. Like its JavaScript support, the automation 
of Illustrator’s Actions panel can help make up for some of the features you 
consider missing relative to FreeHand.
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Exploring Illustrator’s Live Features
Since version 8, Illustrator has become increasingly centered on more and 
more elaborate live behavior. These are treatments that remain adjustable 
until they are nailed down by an Expand command or by being exported to 
a format that does not support the effect.

Of course, FreeHand has its share of live behaviors, too. They range all the 
way from things as mundane as blends to newer Illustratorish features such 
as transparency. In fact, when you think about it, even something as com-
mon as an ordinary stroke weight can be considered a live behavior. But 
here, we’re talking bigger than that. These are major feature sets that the 
FreeHand user should explore (see Chapter 3, Objects, Groups, and Layers, 
and Chapter 8, 3D and Other Live Effects in Real World Adobe Illustrator CS3) 
to appreciate their potential.

Working with Brushes

FreeHand has live brushes, but not to the extent of Illustrator’s selec-
tion. Roughly speaking, Illustrator’s Art brush is analogous to FreeHand’s 
Paint brush, and an Illustrator Scatter brush is similar to a Spray brush in 
FreeHand.

But FreeHand has nothing like Illustrator’s Pattern brush, with its separate 
tiles for ends, sides, and corners. Pattern brushes can be used for one-time 
setups of complex objects ranging from border frames with special treat-
ments at the corners to nuts and bolts with adjustable diameters and lengths 
(Figure 15).

Some capabilities in FreeHand’s brushes are not replicated in Illustrator. For 
example, FreeHand’s Spray brush lets you apply multiple different symbols 

Figure 15  Pattern brushes 
can have ends and corners 
that are different from the 
artwork used along their 
length. You can draw com-
plex objects once and apply 
them to simple spine paths.
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within a single brush definition, whereas Illustrator’s Scatter brush does not. 
Both treatments have their advantages. However, we suspect you will come 
to agree that Illustrator’s brushes are, overall, more satisfying in terms of 
capability and results.

Using Warps

Think of Illustrator’s Warp commands (under the Effect menu) as presets of 
the most commonly needed Envelope shapes, but within a dialog that pres-
ents the most commonly needed distortions in the form of sliders (Illustra-
tor also has a powerful Envelope function for more customized uses). You 
can use the Warp effect in a blend, as explained in Chapter 10, Graphs, Dis-
tortion, and Blends, (Figure 16). This feature set is a huge time-saver.

Figure 16  If you apply the same Warp effect to two copies of the same artwork, you 
can blend it; the ends of the blends are still live and editable. This is a great technique 
for export to Flash.

Exploring the Symbolism Toolset

FreeHand’s Graphic Hose can be much more down-to-business productive 
than Illustrator’s Symbol Sprayer when you just want to spray a bunch of 
same objects in a line or within an area. But, oh my, the things you can do 
with the other symbolism tools after you put the symbols down! A crowd 
favorite is the Symbol Stainer tool. To use it, spray a bunch of symbols on 
the page, and then softly and subtly colorize them en masse: very cool and 
very useful. Be sure to check out Chapter 5, Brushes, Symbols, and Masks 
(Real World Adobe Illustrator CS3), for more details.

Adding Dimension with the 3D Effects

FreeHand’s Extrude feature is not 3D. It is a 2D construction for simulating 
3D objects, much like perspective construction on a drawing board.
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Illustrator’s 3D Effect is 3D. It renders to a 2D image, of course, as does any 
3D program, but it renders as vector paths, rather than pixels. An actual 3D 
engine is used to generate the model (Figure 17).

Understand, this is not meant to denigrate FreeHand’s approach. Both 2D 
construction and 3D modeling have their purposes and advantages, depend-
ing upon what you are trying to do. But the greater realism of the 3D effect 
in Illustrator is plain to see when you first use it. It also offers two major 
capabilities that FreeHand’s does not: parallel perspective (essential to tech 
illustrators, online game builders, and so on) and artwork mapping (great 
for package designs, labeling, and much more).

You can also blend between objects that have the same type of 3D effect 
applied. For example, apply a 3D effect to a path, make a copy, and blend 
between the two. Then modify the parameters of 3D effect applied to 
one. The blend updates accordingly. Release to layers, export to SWF, and 
you’ve got a frame-by-frame animation in much less time than you’d need 
to build something similar in FreeHand. Be sure to read Chapter 8, 3D and 
Other Live Effects, and Chapter 11, Web and Mobile Design (Real World Adobe 
Illustrator CS3), for more information on this subject.

Figure 17  The simple paths 
at the top of this figure are 
all you need to generate the 
3D chess piece renderings at 
the bottom.
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Getting Creative with the Scribble Effect

Scribble is not a single effect; it’s a whole feature set. The obvious use, of 
course, is to make a fill or a stroke look . . . well, scribbled. But you can 
also use this to quickly render a wide variety of effects from embroidery to 
television interference. Be sure to read Chapter 8, 3D and Other Live Effects 
(Real World Adobe Illustrator CS3), where this is discussed in more detail, and 
explore this feature set into the wee hours (Figure 18).

Working with Live Effects

Here’s where it really hits home: the major live effects in Illustrator can 
often be combined to produce elaborate treatments that would be very 
time-consuming to replicate in FreeHand; these capabilities are not always 
evident in a mere surface exploration of the individual features.

For example, you can create a blend between two copies of the same 3D 
object that have different orientations. This greatly expedites the process of 
building frame-by-frame animations to use in Flash.

Another example of combining effects involves blending between two sym-
bol instances. To achieve this, drag two instances of a symbol onto the page. 
Blend them. Now direct select one, and use the Symbol Stainer tool to col-
orize it. The possible combinations go on and on.

Figure 18  The shimmer 
effect used here is based on 
the Scribble effect applied 
to two fills. By using two 
slightly different Scribble 
angles, you can produce the 
interference pattern.

Figure 18  The shimmer 
effect used here is based on 
the Scribble effect applied 
to two fills. By using two 
slightly different Scribble 
angles, you can produce the 
interference pattern.
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Taking the Leap of Faith
This guide is already way over its space budget. It would have to be an 
entire book to exhaustively compare every feature of FreeHand to Illustrator. 
But if it functions well as a “leg up” over the initial getting-acquainted curve, 
it will have served its purpose.

So hop to it, FreeHanders. The Illustrator community needs you. Put your 
noses to the Illustrator grindstone, and try to learn its every nuance. Then, 
when you’re up to speed (it won’t take long), be sure to let Adobe know 
what you like and don’t like about Illustrator, what you’ve always loved 
about FreeHand, and that what we’re all expecting from the company is an 
absolutely best-ever vector drawing program (Adobe is always happy to hear 
from its users).

You can also reference the following additional materials when moving  
from FreeHand to Illustrator:

•	 FreeHand to Illustrator Migration Guide. This is an in-depth  
guide published by Adobe and is available at http://www.adobe.com/
designcenter/illustrator/articles/illcs2ip_fhillmigr/illcs2ip_fhillmigr.pdf.

•	 Migrating from FreeHand to Illustrator CS3. This is a video train-
ing title published by lynda.com and is available at www.lynda.com.
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